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You might consider incorporating images into
your course content:
• to make it easier for your students
to follow and remember the content,
• to illustrate complex concepts,
• as part of the course content,
• as a way to engage students with different learning styles,
• to set the context of a topic,
• to enrich the learning climate, or
• simply to dress it up.

Formats
Tips for Success
Resources
Resizing with Photoshop

Accessibility
Images increase download time - there’s just no getting around that. So,
before you run off and flood your Blackboard site and PowerPoint
presentations with graphics, think about why you’re using the images.
The reason for the image may help you determine the way it is included
(or not) for online delivery. Sometimes images used in lecture can be
removed from a PowerPoint presentation before posting it to the web
making it easier for students to access the material. At times when the
images are necessary, it may be important to warn students that
particular files may take a long time to download from a dial-up modem.

Inclusive Classroom Considerations
When working with images, especially images of other human beings, it is
important to take several things into consideration. While no one would
consciously teach in a manner that would exclude students, sometimes we
do things unconsciously that make certain students or groups of students
feel uncomfortable or not involved in the class. You know what you are
trying to accomplish by using a particular image, but the students will not.
They will make assumptions and draw conclusions based on the image or
images you use. Images are powerful and we need to use them
thoughtfully.
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Here are some questions to ask when selecting images for use.
Who is included? Who is not included?
How are those who are included represented? Positively or
negatively?
Do the images reinforce stereotypes in any way? (If they do, or
might to some students, don’t use them.)
What assumptions might students make from the images you
use?
For an excellent discussion of this topic, see the following publication
(also included in your red folder):

“Every student

Cultural Diversity in Publications: Guidelines for Good
Practice
The University of Melbourn
http://www.unimelb.edu.au/diversity/pdf/CD_Publications.pdf

should have a person
who wants to help
him or her become
the person he or she
is capable of
becoming.”
-Louis Schmier

General Strategies for Teaching and Presentation
http://ds.uoregon.edu/fac_guide/
Highlight major concepts and terminology both orally and visually. Be
alert for opportunities to provide information in more than one sensory
mode.
Use visual aides such as diagrams, charts, and graphs; use color to
enhance the message.

Working with Students with Disabilities
(Material taken verbatim from cited website.)
University Of Oregon Disability Services Homepage
http://ds.uoregon.edu/
Disability Services Faculty Guidebook
http://ds.uoregon.edu/fac_guide/
Strategies for Optimizing Learning
http://ds.uoregon.edu/fac_guide/opti_lear.htm
Many teaching strategies that assist students with disabilities are
also known to benefit students without disabilities. Instruction
provided in an array of approaches will reach more students than
instruction using one method. The following suggestions are
designed to assist you in meeting the growing diversity of student
needs in the classroom, particularly those related to disabilities.
Please let us know if there are other strategies that you have found
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to be effective
Two Important Points
The needs of and necessary accommodations for students with
disabilities will vary dramatically even within the same disability type.
Always talk with the student about her/his specific needs and consult
with Disability Services as needed.
Most disabilities are not obvious. NEVER assume that you do not
have a student with a disability in your class.
Place a statement in your syllabus and make an announcement
at the first meeting of the class such as:
"If you have a documented disability and anticipate needing
accommodations in this course, please make arrangements to meet
with me soon. Please bring a notification letter from Disability Services
outlining your approved accommodations."
Faculty Guidebook
Optimizing Learning for Students with Specific Disabilities
http://ds.uoregon.edu/fac_guide/fg_opt_spef.htm
The following pages address some categories of disabilities and include a
definition, characteristics, considerations, instructional strategies, and
accommodations which may be recommended to assist the student.
Blind/Low Vision
Accommodations (may include): (edited list)
http://ds.uoregon.edu/fac_guide/fg_opt_spef.htm#two
Reading aloud materials from overheads, blackboards or
handouts
Giving a verbal description of class activity, such as when a
show of hands is requested, stating how many hands were
raised
Using black print on white paper to allow for maximum
contrast
Making class assignments available in an electronic format,
such as e-mail, to allow access by computers equipped with
voice synthesizers or Braille output devices
Raised line drawings and tactile models of graphic materials

Page 3 of 12

Understanding Digital Images

Page 4 of 12

University of Oregon Adaptive Technology
Designing Web Accessibility for People with Disabilities
http://darkwing.uoregon.edu/~atl/web_acs.htm

“The highest reward
for man’s toil is not
what he gets from it

Images
http://darkwing.uoregon.edu/~atl/awp5.htm#80
Always include an informative "alt text". Some designers
recommend rather detailed descriptions. Try at least to avoid being
vague. "University of Oregon Logo" is better than just "Logo." A
good test is to clear your cache, turn images off, and navigate your
site. You should be able to quite easily.

but what he
becomes by it.”
-John Ruskin

Copyright and Fair Use
Educational use of copyrighted material can sometimes be justified
through the "fair use" clause in federal copyright law. The goal of this
section is to briefly define the elements of "fair use" and to lead you to
more substantial sources for information about how copyright law applies
to teaching with the Internet.

Factors of Fair Use
If you use a piece of copyrighted material in your teaching, four factors
will determine whether or not your use of that material qualifies as "fair
use." Note that ALL FOUR of these factors must be evaluated for fair use
to apply.
1. What is the nature of the use? Is the reproduction or the
distribution for education or for commercial gain?
2. What is the nature of the copyrighted work? Fiction, highlevel analysis, works of art, and musical composition are
considered the most creative and therefore receive the most
protection from infringement. Compilations and derivative works
are usually not protected by copyright at all (except possibly in
their format or user interface).
3. What is the quantity of the work used? If you use 3% of the
total substance of the work or less, you are probably safely within
fair use. If you use more than 10%, you are in uncertain territory.
4. What is the potential impact on the copyright holder's
market? If your use of some material could materially reduce the
creator's ability to profit from it, this factor would point toward
your use not being "fair".
The fact that a work is unpublished shall not itself bar a finding of fair use
if such finding is made upon consideration of all the above factors. NCSU’s
Copyright Tutorial (http://www.lib.ncsu.edu/scc/tutorial/basicsintro.html)
provides more information on each of the four Fair Use criteria.
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Additional sources of information are:
Copyright Principles in Action
(http://darkwing.uoregon.edu/~copyrght/)
The CONFU website (U.S. Patent and Trademark Office)
(http://www.uspto.gov/web/offices/dcom/olia/confu/)
The Educational Multimedia Guidelines
(http://www.uspto.gov/web/offices/dcom/olia/confu/appendix.htm#j)
Christine Sundt's Copyright & Art Issues
(http://darkwing.uoregon.edu/~csundt/copyweb/)
Stanford University Copyright and Fair Use
(http://fairuse.stanford.edu/)

What Determines File Size?
File size is an important factor when working with digital images. Your
intended use for the image will play a large part in determining the
acceptable file size. The file size for high quality print images will
undoubtedly be much larger that images intended for web use, while
images to be displayed through presentation software such as PowerPoint
will fall somewhere in between.

Image Dimensions
When we talk about the Image dimensions we are referring to the actual
width and height of the image. A full screen image displayed on a 13"
monitor is 640 pixels by 480 pixels. Typical dimensions for Mac and PC
monitors are 832 pixels x 624 pixels for a 17" monitor and 1024 pixels x
768 pixels for a 21 " monitor (more or less).
You will determine your image dimensions at the time you digitize. These
dimensions can be decreased at any time. Increasing the dimensions will
distort the image, however. Therefore, if you are unsure about the final
dimensions or you have multiple uses in mind, you should set your
dimensions to the largest size you may want and decrease them as
needed.

Image Resolution
Image resolution is defined as the number of pixels per inch, or ppi, when
talking about on screen display, and dots per inch, or dpi, when referring
to print images. These measurements refer to the spacing of pixels in your
image. The resolution you want will depend on what you intend to do with
the image. The following are basic guidelines.

“The ability to
perceive or think
differently is more
important than the
knowledge gained.”
-David Bohm
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What Determines File Size?

Continued

Monitor Display--If you intend to display the image on a monitor,
the final image resolution need only be between 72 ppi and 96 ppi.
Digitizing at a higher resolution such as 150 ppi or 300 ppi would be
suggested if you plan to manipulate your image. More pixels mean
more information to manipulate and less unwanted distortion from
manipulation. After you have finished any manipulations, you can
reduce the image resolution down to 72 or 96 ppi to decrease file size.
Print Quality--If you intend to print the image, you will want the
highest resolution the printer can support, usually 300 dpi to 2400 dpi.
The resolution of your image can be decreased any time after
digitizing. Increasing the resolution will distort the image, however.
Therefore, if you are unsure of your intended output or have multiple
uses in mind, it is advised that you set your resolution size to the
maximum you will require and decrease it later as you create
additional files.
Every pixel translates into digital information, so there is a direct
correlation between the size and resolution of an image and how large the
file will be when the image is saved.
File size increases dramatically as resolution increases. When working
with digital images, it is important to consider how to balance the size and
quality you wish to have while also maintaining a file size that does not
take up more disk space than required and is small enough to allow
convenient uploading and downloading.

Image Bit-Depth (Pixel Resolution)
Image bit-depth refers to the number of bits of stored information per
pixel. Each pixel contains data that describes whether it is black, white, or
a level of color. (Storing the information in a single pixel can take different
amounts of memory, depending on how much grayscale or color
information is needed.) As a general guide:
A black-and-white pixel takes only 1 bit to store the information
An 8-bit grayscale (256-level gray-scale) pixel takes 8 bits to
store the information.
An 8-bit color (256 colors) pixel takes 8 bits to store the
information
A 16-bit color (thousands of color) pixel takes 16 bits to store the
information
A 32-bit color (millions of color) pixel takes 24 bits to store the
information
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What Determines Storage Options for a File?
Where you will be able to store your file depends on three things: image size,
the storage media available to you and the computers you're working on.

Image File Size
Image file size is usually expressed in Kilobytes (K), Megabytes (MB), or
Gigabytes (GB) and is proportional to resolution. Keep in mind that 1000 K is
more or less equivalent to 1 MB and 1000 MB is more or less equivalent to 1
GB. For instance, your full screen, (640 pixels by 480 pixels), image set at a
resolution of 72 ppi will take up approximately this much disk space … (Note
that these file sizes do not take into account compression).
A black-and-white image will occupy 100 K
An 8-bit grayscale/color image will occupy 300K
A 16-bit color image will occupy 600K
A 32-bit color image will occupy 1000K

Storage Media
Common types of storage media are changing with the emergence of new
technologies. Frequently you may choose to use CD-Rs (approximately 650MB
of storage) Zip disks, (100-250 MB depending on the type) or another type of
external storage device such as a keychain storage system. It is best to know
which storage media you will need to use before you begin digitizing. What
type of storage you can use will depend on the file size and what equipment is
available at the workstation. Some computers are equipped with more than one
option for storage.

Computer Platform
Often your storage media may come preformatted for either Mac or Windows
but which format you can use depends on what computers you will be working
on. IBM computers will NOT read Macintosh formatted media. Therefore, if your
storage device will, at any time in this process, need to be inserted into a PC,
you MUST use an Windows formatted or Windows compatible device. Macintosh
computers will read media formatted for either platform. So... if you digitizing
on a PC for use on either platform, you need to use a Windows formatted
storage device. If you intend to take the file to a PC after digitizing, you will
also need to use an Windows formatted storage device regardless of the
platform you are digitizing on. If you are using a Macintosh and plan to take it
to a Macintosh, the formatting of your storage device is generally not a factor.
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What are the different formats I can use?
Which should I choose?
“In wisdom gathered
over time I have
found that every
experience is a form
of expression.”
-Ansel Adams

The format you use to save your file will be determined by its intended
use. Some formats are common for the web, others for presentation or
print. There are several graphic file formats you may encounter. Listed
below are some of the most common. Many programs will accept
several file formats and may possibly convert others. Knowing your
program is the best way to determine which format will work best for
you. Files can be converted from one format to another with little
trouble. Be aware though that some formats remove information from
the images in order to decrease the file size and this information
cannot be retrieved at a later time by conversion to a different format.
PICT stands for 'Picture' and is used for storing 8-bit, 16-bit or
24-bit color or gray scale images. PICT files work well for the onscreen presentation of graphics. This is the preferred standard for
many Authoring, Presentation and Word Processing software
packages although several of these programs will also take JPEG
files, (explained below). NOTE: Remember that the .pic
extension is needed for PC files.
TIFF stands for 'Tagged Image File Format' and is used for
storing grayscale and color images. TIFF files retain more
information that PICT files and therefore create a larger file. This
format is used frequently when an image is used for display or
print. This is one of the preferred formats for most Desktop
Publishing software packages. NOTE: Remember that the .tif
extension is needed for PC files.
GIF stands for 'Graphic Interchange Format', which is used for
simple web images. Because GIF files are limited to 256 colors, it is
suggested that you not use this format for photographs or other
images with high color ranges. Note also that you can make the
background of GIF files transparent, which works well for web pages
with tiled backgrounds. NOTE: Remember that the .gif
extension is needed for PC files.

“There is no try;
there is only do or
not do.”
-Yoda

JPEG stands for Joint Photographic Experts Group. JPEG is
actually not a file format even though it is frequently referred to as
one. It is actually a standard method of compressing graphics by
removing nonessential information. Because saving as a JPEG
removed information from the image, it is suggested that you do
not save using this file format until you are finished manipulating
your image. A JPEG file can be created from most file formats and is
frequently used for web-based images because small file size is
essential. NOTE: Remember that the .jpg extension is needed
for PC files.
Bit Map images are used for simple black and white images.
Note that 'black and white' refers to those images that have only
two tones, either black or white. Images that contain a range of
grays, (like black and white photographs do), are called grayscale
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Bit Map images are used for simple black and white images. Note
that 'black and white' refers to those images that have only two tones,
either black or white. Images that contain a range of grays, (like black
and white photographs), are called grayscale images. You do not want
to save grayscale images as Bit Map files. Doing so will translate the
value of the grays to either a black or white tone and you will distort
your image. NOTE: Remember that the .bmp extension is needed
for PC files.
For the purposes of sharing files, adding images to PowerPoint
presentations and posting them to websites, the formats you are most
likely to use are JPG and GIF. These files are almost universally readable
by image editors, work well on websites, and offer small file sizes with
reasonable quality levels.

Working with Digital Image Files
The UO Distance Education Program offers these tips regarding working
with digital image files:
“People change more
often because they
feel the heat than
because they see the
light.”
-Janet Feldman

Use JPG (also seen as JPEG) or GIF files
For images that will just be used on web pages, the files should not
be very large (less than 300k)
If you are going to share files, keep file names simple and easy to
type
Use descriptive file names for images to make it easier to
remember what they are - selfportrait.jpg, sunset.gif, or
artmuseum.jpg, for example
Keep back-up copies: NEVER WORK ON AN ORIGINAL FILE! Always
save a copy of an image before doing anything to it - some changes
cannot be undone
Color is information - Black and White images result in smaller files
than Color images
Large images on web pages take a long time to load - keeping
images small and at screen resolution not only helps to make
uploading them easier, but it makes the web page they are on load
faster
Establish a specific place to save your images - a "My Pictures"
directory on your hard drive, for instance, or a particular Zip drive,
CD-R/RW, etc. that is used only for image files - this makes it much
easier to find the files later on when you need to upload them or
otherwise work with them

Understanding Digital Images

Working with Digital Image Files
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Continued

Save your work: save an original copy for safekeeping, and then
save another copy every time you are about to make a significant
change to the image - this way you can always go back if you don't
like the result

Changing Image Size in Photoshop
This brief tutorial will show you the basic information necessary to take a
digital photograph and change its size (both in terms of height and width as
well as computer file size) so that it can be used on the Internet. It was
originally created for student use by the UO Distance Education program and
can be found in its original form online at:
http://de.uoregon.edu/help/changePS.html. With permission, it has been
adapted for our purposes included in this handout.
The program used is Adobe Photoshop, which is a high-end graphics
program available at almost every UO computer lab, including the FITT
Center. Follow these instructions to prepare a picture for posting to a website
or for inclusion in your PowerPoint presentation.
Note: If you do not have access to this software, the basic information and
procedures will work with any digital imaging program that has similar
capabilities; the terminology may differ, and the controls may not be the
same, but the basic aspects of size and resolution are the same no matter
what the software being used.
1. Pull down the File menu to select Open.
2. Locate your image file and click Ok. Your image should open up in
Photoshop. Before doing anything else, SAVE A COPY OF YOUR
PICTURE! This way, if you make any mistakes you always have a
back-up of your file.
3. Pull down the File menu to Save As.
4. Rename the file so you can easily distinguish it from the original.
5. Click the Save button. Now that you have a copy for safe-keeping
you can resize the new image file.
6. Pull down the Image menu select Image Size.
7. A window will open with the information about your
particular image file.
As you can see from this information, the picture opened is 5.145
inches wide and 8.298 inches tall, so it would fit comfortably on a
letter-size piece of paper. At this height and width, the resolution is
228 pixels per inch (ppi). The combination of these, the height and
width of the picture along with the resolution, results in a file that is
6.35 megabytes in size - far too big to be reasonably used on the
web. The picture we see displayed on our computer screen does not
look huge, but that is because it is being shown at a reduced size. We
need to change the size of this image before it can be used on the Internet.
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Check out what happens if we change the size (height and width)
of the picture without adjusting the resolution (pixels/inch). Note
that the resolution has jumped to 540.571 pixels per inch! This
happened because the highlighted box was turned off. Resample
Image needs to be on for changes to be made to one or the other
characteristic of an image without also affecting the other. It’s also
a good idea to leave Constrain Proportions checked. This option
automatically updates the width as you change the height, and vice
versa.
Since we only want to use the picture on the Internet, we do not
need a resolution higher than a computer screen can show. The
general standard for computer monitors is either 72 or 96 ppi, so
choose one of these resolutions for your picture.
In the picture to the left, you can see the final result of the change
- we now have an image that is 2.17 inches wide, 3.5 inches tall,
and has a resolution of 72 pixels per inch. Notice that the file size
is now only 116 kilobytes, which is appropriate for use on the web.
(The original file was 6.35M, or 6,350,000 bytes of information
while the new file is 116,000 bytes.
The last thing you need to do now is Save the new, web-ready
version of your image. Give it a new name to avoid saving over
your original version. For most purposes you will want to use the
JPEG file format (also seen as JPG). JPEG is a kind of file that can
be read by web browsers, is capable of very high image quality,
and also uses less space on a disk than most other picture file
formats. If you do not use the right file format your pictures
will not work on the Internet, so be sure that you save in
JPEG format to be sure your images will be ready to use on
the web. There are other formats that will work, but for most
purposes you are safest sticking with JPEG files.

Resources
Download Time Calculator
(http://www.absolutecross.com/webmaster/tools/download-time/)
This tool will help you quickly calculate how long your file will take to
download with certain Internet connections.

Adobe Photoshop Tutorials
Teaching
Effectiveness
Program

www.adobe.com/products/tips/photoshop.html
This site offers tips on converting color images, retouching, using layer
comps, posterization, and more.

Academic
Learning Services
Phone:

(541) 346-3226
E-Mail:

tep@uoregon.edu

Be Free
To Teach
We’re on the Web!
See us at:

tep.uoregon.edu

About Our Organization…
The University of Oregon supports the teaching endeavors of its faculty
and graduate students through the Teaching Effectiveness Program (TEP),
a division of Academic Learning Services.
The Teaching Effectiveness Program offers a variety of activities and
services to engage the academic community in viewing, assessing, and
improving undergraduate instruction. TEP services are free to faculty
members, graduate teaching fellows (GTFs), and university departments.

